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THIEÁT KEÁ VAØ VEÕ SÔ ÑOÀ MAÏCH IN  
MAÏCH AVR 1 PHA VIEÄT NAM. 

 Trong baøi taäp naøy baïn seõ ñöôïc höôùng daãn thieát keá sô ñoà maïch in cho maïch AVR 1 pha 
Vieät nam coù sô ñoà nguyeân lyù nhö sau: 
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Ñeå khôûi ñoäng chöông trình veõ sô ñoà nguyeân lyù trong ORCAD, nhaáp choïn Start > 
Programs > OrCAD Release 9 > Capture. 
 Muoán môû moät trang môùi, nhaáp choïn File > New > Project…. 

 
 Hoäp thoaïi New Project xuaát hieän. Taïi khung Create a New Project Using, nhaáp choïn 
muïc Schematic. Taïi khung Name, nhaäp teân caàn ñaët cho maïch ñieän. Taïi khung Location nhaáp 
chuoät vaøo nuùt Browse ñeå choïn ñöôøng daãn cho maïch ñöôïc gôûi vaøo. Khi choïn xong taát caû nhaáp 
chuoät vaøo nuùt OK. 

 
 Trong sô ñoà nguyeân lyù coù caùc linh kieän nhö sau: 34 ÑIEÄN TRÔÛ, 1 BIEÁN TRÔÛ, 2 TUÏ 
PHAÂN CÖÏC, 5 DIODE, 1 DIODE ZENER, 2 LED, 12 TRANSISTOR, 2 CHAÂN CAÉM 2 
CHAÂN, 1 CHAÂN CAÉM 3 CHAÂN, 19 CHAÂN MASS, 3 NGUOÀN V1, 2 NGUOÀN V2. 

Maøn hình laøm vieäc cuûa Orcad xuaát hieän, ñeå laáy linh kieän cho maïch, nhaáp chuoät vaøo bieåu 
töôïng Place part treân thanh coâng cuï. 

 
 Hoäp thoaïi Place Part xuaát hieän, khung Libraries khoâng coù nhöõng muïc chöùa linh kieän ta 
caàn neân nhaáp chuoät vaøo nuùt Add Library ñeå laáy muïc chöùa linh kieän ta caàn. 
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 Hoäp thoaïi Browse File xuaát hieän, tröôùc tieân laáy ñieän trôû, nhaáp chuoät vaøo teân Discrete. 
Choïn xong nhaáp Open. 

 

 Hoäp thoaïi Place Part 
xuaát hieän vôùi muïc Discrete ñaõ 
ñöôïc naïp vaøo khung Libraries. 
Ñeå laáy ñieän trôû, nhaáp chuoät vaøo 
muïc Discrete. Taïi khung Part 
nhaáp chuoät vaøo thanh cuoán beân 
phaûi ñeå tìm R. Khi tìm thaáy 
ñieän trôû thì nhaáp choïn noù. Choïn 
xong nhaáp OK. Con troû chuoät 
xuaát hieän hình daïng linh kieän 
caàn, di chuyeån noù ra maøn hình 
laøm vieäc vaø nhaáp chuoät taïi 
nhöõng vò trí khaùc nhau ñeå choïn 
vò trí, soá löôïng ñieän trôû. 

 

ÑAÏI HOÏC SÖ PHAÏM KYÕ THUAÄT – KHOA ÑIEÄN   BIEÂN SOAÏN : PHAÏM QUANG HUY  -  HUYØNH MINH ÑAÊNG 159 



GIAÙO TRÌNH EDA (ELECTRONIC DESIGN AUTOMATION) - TÖÏ ÑOÄNG THIEÁT KEÁ MAÏCH ÑIEÄN TÖÛ VÔÙI ORCAD          BAØI TAÄP 7 
 

 Ñeå tieáp tuïc laáy bieán trôû nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï, hoäp 
thoaïi Place Part xuaát hieän. Taïi khung Libraries nhaáp choïn muïc Discrete, taïi khung Part nhaáp 
choïn teân RESISTOR VAR. Choïn xong nhaáp OK vaø di chuyeån con troû ra maøn hình laøm vieäc ñeå 
nhaáp choïn vò trí bieán trôû. 

 
 Ñeå choïn tuï phaân cöïc, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. Hoäp 
thoaïi Place Part xuaát hieän, taïi khung Part nhaáp choïn teân CAPACITOR POL. Choïn xong nhaáp 
OK vaø di chuyeån con troû ra maøn hình laøm vieäc nhaáp choïn vò trí, soá löôïng tuï. 

 
 Tieáp tuïc ta laáy Diode baèng caùch nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng 
cuï. Hoäp thoaïi Place Part xuaát hieän, taïi khung Part nhaáp choïn teân DIODE. Choïn xong nhaáp 
OK vaø di chuyeån con troû ra maøn hình laøm vieäc roài nhaáp choïn vò trí, soá löôïng Diode. 
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 Ñeå choïn Diode 
zener, nhaáp chuoät vaøo 
bieåu töôïng Place part 
treân thanh coâng cuï. Hoäp 
thoaïi Place Part xuaát 
hieän, taïi khung Part 
nhaáp choïn teân DIODE 
ZENER. Choïn xong 
nhaáp OK vaø di chuyeån 
con troû ra maøn hình laøm 
vieäc nhaáp choïn vò trí, soá 
löôïng zener. 

 
 Ñeå choïn Led, 
nhaáp chuoät vaøo bieåu 
töôïng Place part treân 
thanh coâng cuï. Hoäp 
thoaïi Place Part xuaát 
hieän, taïi khung Part 
nhaáp choïn teân LN01201. 
Choïn xong nhaáp OK vaø 
di chuyeån con troû ra 
maøn hình laøm vieäc nhaáp 
choïn vò trí, soá löôïng 
Led. 
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 Ñeå laáy Transistor 
(khoâng coù trong muïc naøy), nhaáp 
chuoät vaøo bieåu töôïng Place 
part treân thanh coâng cuï. Hoäp 
thoaïi Place Part xuaát hieän, ñeå 
laáy muïc coù chöùa Transistor 
nhaáp chuoät vaøo nuùt Add 
Library. 

 
 Hoäp thoaïi Browse File xuaát hieän, nhaáp chuoät vaøo thanh cuoán beân döôùi ñeå tìm vaø choïn 
muïc Transistor. Choïn xong nhaáp Open. 

 

 Hoäp thoaïi Place Part 
xuaát hieän, taïi khung Libraries 
nhaáp choïn muïc 
TRANSISTOR. Taïi khung 
Part nhaáp choïn Transistor 
caàn, ôû ñaây ta nhaáp chuoät vaøo 
teân BC 109. Choïn xong nhaáp 
OK vaø di chuyeån con troû ra 
maøn hình laøm vieäc roài nhaáp 
choïn vò trí, soá löôïng 
Transistor. 
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 Tieáp tuïc ta laáy caùc chaân 
caém cho maïch, ta nhaáp chuoät 
vaøo bieåu töôïng Place part treân 
thanh coâng cuï. Hoäp thoaïi Place 
Part xuaát hieän, nhaáp chuoät vaøo 
nuùt Add Library ñeå laáy muïc 
chöùa chaân caém. 

 

 Hoäp thoaïi Browse File xuaát hieän, nhaáp chuoät vaøo thanh cuoán beân döôùi ñeå tìm vaø choïn 
muïc Connector. Choïn xong nhaáp OK. 

 

 Hoäp thoaïi Place Part 
xuaát hieän, taïi khung Libraries 
nhaáp choïn muïc CONNECTOR. 
Taïi khung Part nhaáp choïn chaân 
caém caàn, ôû ñaây ta nhaáp chuoät 
vaøo teân CON2. Choïn xong nhaáp 
OK vaø di chuyeån con troû ra 
maøn hình laøm vieäc roài nhaáp 
choïn vò trí, soá löôïng chaân caém. 
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 Ñeå choïn chaân caém 3 chaân, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. 
Hoäp thoaïi Place Part xuaát hieän, taïi khung Part nhaáp choïn teân CON3. Choïn xong nhaáp OK vaø 
di chuyeån con troû ra maøn hình laøm vieäc nhaáp choïn vò trí chaân caém naøy. 

 
 Ñeå laáy nguoàn Mass cho maïch, nhaáp chuoät vaøo bieåu töôïng Place ground treân thanh coâng 
cuï.  

 
 Hoäp thoaïi Place Ground xuaát hieän, taïi khung Symbol nhaáp choïn teân 
GND_POWER/CAPSYM. Choïn xong nhaáp OK vaø di chuyeån con troû ra maøn hình laøm vieäc roài 
nhaáp choïn vò trí, soá löôïng chaân Mass caàn cho maïch. 
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 Ñeå laáy nguoàn V1 cho maïch, nhaáp chuoät vaøo bieåu töôïng Place power treân thanh coâng cuï. 

 
 Hoäp thoaïi Place Power xuaát hieän, taïi khung Symbol nhaáp choïn teân VCC 
ARROW/CAPSYM. Choïn xong nhaáp OK vaø di chuyeån con troû ra maøn hình laøm vieäc roài nhaáp 
choïn vò trí, soá löôïng chaân V1 caàn cho maïch. 

 
 Ñeå laáy nguoàn V2 cho maïch nhaáp chuoät vaøo bieåu töôïng Place power treân thanh coâng cuï. 
Hoäp thoaïi Place Power xuaát hieän, taïi khung Symbol nhaáp choïn teân VCC CIRCLE/CAPSYM. 
Choïn xong nhaáp OK vaø di chuyeån con troû ra maøn hình laøm vieäc roài nhaáp choïn vò trí, soá löôïng 
chaân V2 caàn cho maïch. 

 
 Sau khi taát caû caùc linh kieän ñaõ ñöôïc laáy ra maøn 
hình laøm vieäc, ñeå hình daïng linh kieän khoâng xuaát hieän taïi 
con troû chuoät nöõa, nhaáp chuoät vaøo bieåu töôïng Select treân 
thanh coâng cuï.  
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 Sau khi laáy taát caû caùc linh kieän ra maøn hình laøm vieäc, caùc linh kieän ñöôïc laáy ra nhö sau: 

 
 Tieáp tuïc tieán haønh saép xeáp linh kieän. Muoán di chuyeån linh kieän, chæ vieäc nhaáp chuoät vaøo 
bieåu töôïng linh kieän vaø reâ chuoät. Muoán quay linh kieän ñoái xöùng qua truïc ñöùng, nhaáp choïn linh 
kieän roài nhaáp phaûi chuoät. Moät cöûa soå xuaát hieän, nhaáp chuoät vaøo Mirror Horizontally. Muoán 
quay linh kieän moät goùc 90o, nhaáp choïn linh kieän roài nhaáp phaûi chuoät. Moät cöûa soå xuaát hieän, 
nhaáp chuoät vaøo Rotate. Muoán quay linh kieän ñoái xöùng qua truïc naèm ngang, nhaáp choïn linh kieän 
roài nhaáp phaûi chuoät. Moät cöûa soå xuaát hieän, nhaáp chuoät vaøo Mirror Vertically. 

     
 Trong khi di chuyeån, coù khi cho chaân linh kieän naøy chaïm chaân linh kieän kia. Hoäp thoaïi 
OrCAD Capture xuaát hieän raèng neáu muoán noái hai chaân linh kieän naøy vôùi nhau thì nhaáp OK. 
Neáu khoâng muoán noái thì nhaáp OK roài nhaáp vaøo bieåu töôïng Undo treân thanh coâng cuï ñeå di 
chuyeån laïi. 

 
 Sau khi di chuyeån caùc linh kieän theo sô ñoà nguyeân lyù, caùc linh kieän ñöôïc saép xeáp nhö 
sau: 
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 Ñeå thay ñoåi giaù 
trò linh kieän, nhaáp ñuùp 
chuoät vaøo giaù trò linh 
kieän caàn thay ñoåi. Hoäp 
thoaïi Display 
Properties xuaát hieän, 
taïi khung Value nhaäp 
giaù trò caàn ñaët cho linh 
kieän. Nhaäp giaù trò xong 
nhaáp OK. 

 
 Trong khi thay ñoåi 
giaù trò linh kieän, coù nhöõng 
giaù trò linh kieän khoâng caàn 
thay ñoåi cuõng nhö khoâng 
muoán cho noù xuaát hieän treân 
maïch ñieän, nhaáp ñuùp vaøo 
giaù trò linh kieän ñoù. Hoäp 
thoaïi Display Properties 
xuaát hieän, taïi khung 
Display Format nhaáp 
chuoät vaøo muïc Do not 
Display. Choïn xong nhaáp 
OK.  
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 Tieáp tuïc tieán haønh noái chaân caùc linh kieän theo sô ñoà nguyeân lyù, 
nhaáp chuoät vaøo bieåu töôïng Place wire treân thanh coâng cuï. Con troû chuoät 
thay ñoåi thaønh hình chöõ thaäp, nhaáp chuoät taïi chaân linh kieän caàn noái roài 
di chuyeån con troû ñeán chaân linh kieän caàn noái vôùi noù vaø nhaáp chuoät. 

 
 Cöù theá tieáp tuïc cho ñeán khi taát caû caùc linh kieän ñöôïc noái theo sô ñoà nguyeân lyù sau: 

 
 Ñeå kieåm tra loãi cho sô ñoà nguyeân lyù vaø 
chuyeån sang sô ñoà maïch in, nhaáp chuoät vaøo bieåu 
töôïng Minimize goùc phaûi phía treân maøn hình.  
 Maøn hình nhö sau xuaát hieän, taïi khung beân traùi nhaáp choïn trang PAGE1. Sau ñoù nhaáp 
chuoät vaøo bieåu töôïng Design rules check ñeå kieåm tra loãi. 

 

ÑAÏI HOÏC SÖ PHAÏM KYÕ THUAÄT – KHOA ÑIEÄN   BIEÂN SOAÏN : PHAÏM QUANG HUY  -  HUYØNH MINH ÑAÊNG 168 



GIAÙO TRÌNH EDA (ELECTRONIC DESIGN AUTOMATION) - TÖÏ ÑOÄNG THIEÁT KEÁ MAÏCH ÑIEÄN TÖÛ VÔÙI ORCAD          BAØI TAÄP 7 
 

 Hoäp thoaïi Design Rules Check xuaát hieän, nhaáp chuoät vaøo nuùt OK ñeå tieán haønh kieåm 
tra. Neáu khoâng thaáy thoâng baùo gì nghóa laø maïch khoâng coù loãi. 

 
 Tieáp tuïc, taïo taäp tin coù ñuoâi .mnl ñeå thieát keá maïch 
in. Nhaáp chuoät vaøo bieåu töôïng Create netlist treân thanh 
coâng cuï.  
 Hoäp thoaïi Create netlist xuaát hieän, nhaáp chuoät vaøo Layout, taïi khung Netlist File coù 
theå nhaáp chuoät vaøo nuùt Browse ñeå choïn ñöôøng daãn cho taäp tin ñöôïc göûi vaøo. Choïn xong nhaáp 
OK. 
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 Moät hoäp thoaïi xuaát hieän thoâng baùo laø taäp tin treân seõ ñöôïc Save ñeå keát noái. Nhaáp OK ñeå 
tieáp tuïc. 

 
 Tieáp tuïc chuyeån sang cheá ñoä thieát keá maïch in, ta choïn Start > Programs > OrCAD 
Release 9 > Layuot Plus. 

 
 Maøn hình thieát keá maïch in xuaát hieän, nhaáp chuoät vaøo File > New ñeå môû moät File môùi. 

 
 Hoäp thoaïi Load Template File xuaát hieän, nhaáp chuoät vaøo nuùt Open. 
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 Hoäp thoaïi Load Netlist 
Source xuaát hieän, nhaáp choïn 
teân maïch caàn thieát keá maïch in. 
Choïn xong nhaáp Open. 

Hoäp thoaïi Save File As 
xuaát hieän, taïi khung File name 
nhaäp teân caàn ñaët cho maïch in 
vaøo (tuøy choïn). Nhaäp xong 
nhaáp Save. 

 
Sau moät thôøi gian chôø 

ñôïi, hoäp thoaïi nhö sau xuaát 
hieän. Trong hoäp thoaïi Link 
Footprint to Component thaáy 
thoâng baùo laø khoâng theå tìm 
thaáy chaân maïch in cuûa D7 coù 
teân laø LN01201. Vì theá neân 
phaûi tìm chaân cho linh kieän 
naøy baèng caùch nhaáp chuoät vaøo 
nuùt Link existing footprint to 
component… 

 

  
 Hoäp thoaïi Footprint for LN01201 xuaát hieän, taïi khung Libraries nhaáp choïn muïc 
JUMPER. Taïi khung Footprints nhaáp choïn muïc JUMPER 100 ñeå choïn chaân maïch in cho Led. 
Choïn xong nhaáp Ok. 
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 Hoäp thoaïi Link Footprint to 
Component xuaát hieän, thoâng baùo laø 
khoâng theå tìm thaáy chaân maïch in cuûa Q1 
coù teân laø BC109. Vì theá neân caàn tìm 
chaân cho linh kieän naøy baèng caùch nhaáp 
chuoät vaøo nuùt Link existing footprint to 
component… 

 

 
 Hoäp 
thoaïi 
Footprint for 
BC109 xuaát 
hieän, taïi khung 
Libraries nhaáp 
choïn muïc TO. 
Taïi khung 
Footprints 
nhaáp choïn muïc 
TO202AA ñeå 
choïn chaân 
maïch in cho 
Transistor. 
Choïn xong 
nhaáp Ok. 
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 Hoäp thoaïi Link Footprint to 
Component laïi xuaát hieän vôùi thoâng baùo 
laø khoâng theå tìm thaáy chaân maïch in cuûa 
J3 coù teân laø CON3. Cho neân phaûi tìm 
chaân cho linh kieän naøy baèng caùch nhaáp 
chuoät vaøo nuùt Link existing footprint 
to component… 

 
 Hoäp thoaïi Footprint for CON3 xuaát hieän, taïi khung Libraries nhaáp choïn muïc 
BCON100T. Taïi khung Footprints nhaáp choïn muïc BLKCON.100/VH/TM1SQ/W.100/3 ñeå 
choïn chaân maïch in cho chaân caém. Choïn xong nhaáp Ok. 

 
 Sau khi choïn chaân cho caùc linh kieän ta coù caùc linh kieän trong sô ñoà maïch in nhö sau: 

 
 Tieán haønh saép xeáp caùc linh kieän. Ñeå khoâng bò giôùi haïn bôûi khung 
maïch in coù saün, nhaáp chuoät vaøo bieåu töôïng Reconnect Mode treân thanh 
coâng cuï. 
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 Sau khi nhaáp chuoät vaøo bieåu töôïng Reconnect Mode, caùc linh kieän hieän ra nhö hình. 

 
 Nhaáp chuoät vaøo bieåu töôïng linh kieän vaø reâ chuoät ñeán vò trí caàn ñaët linh kieän roài nhaáp 
chuoät. Muoán quay linh kieän moät goùc 90o, nhaáp choïn bieåu töôïng linh kieän roài nhaáp phaûi chuoät, 
moät cöûa soå xuaát hieän, nhaáp chuoät vaøo Rotate hay nhaán phím R treân baøn phím. 
 Sau khi saép xeáp xong, caùc linh kieän trong maïch ñöôïc saép xeáp nhö sau: 

 
 Ñeå veõ khung giôùi haïn cho maïch in, nhaáp chuoät vaøo bieåu töôïng Obstacle Tool treân thanh 
coâng cuï. 

 
 Con troû chuoät thay ñoåi hình daïng, nhaáp chuoät taïi moät ñieåm caàn ñaët cho khung giôùi haïn, 
di chuyeån con troû ñeán ñieåm caàn ñaët khaùc vaø nhaáp chuoät. Cöù theá tieáp tuïc cho ñeán khi khung 
maïch in hoaøn chænh nhö sau: 

 

 Sau khi khung giôùi haïn maïch in hoaøn 
thaønh, ñeå thoaùt khoûi leänh naøy ta nhaáp phaûi 
chuoät, moät cöûa soå xuaát hieän, nhaáp chuoät vaøo 
End Command. 
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 Ñeå cho maïch in khoâng coøn roái nöõa, cho aån caùc teân khoâng caàn thieát cuûa linh kieän baèng 
caùch taïi khung traïng thaùi, nhaáp chuoät ngay muõi teân höôùng xuoáng cuûa 1 TOP vaø choïn 23 AST. 

 
 Sau ñoù nhaáp choïn View > Visible <> Invisible ñeå cho aån nhöõng teân naøy. Muoán cho hieän 
laïi cuõng tieán haønh laøm caùc böôùc nhö treân. 

 
 Sau khi cho aån teân linh kieän, caùc linh kieän trong maïch nhö sau: 

 
 Ñeå choïn lôùp cho chöông trình chaïy maïch in, nhaáp chuoät vaøo bieåu töôïng daïng caroâ treân 
thanh coâng cuï. Moät cöûa soå xuaát hieän, nhaáp chuoät vaøo Strategy… > Route Layer. 
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 Hoäp thoaïi Route Layer xuaát hieän, nhaáp choïn taïi taát caû caùc oâ trong coät Enable, doøng 
BOTTOM, INNER1, INNER2. Choïn xong nhaáp phaûi chuoät, moät cöûa soå xuaát hieän, nhaáp choïn 
Properties. 

 
 Hoäp thoaïi Edit Layer Strategy 
xuaát hieän, nhaáp boû muïc Routing 
Enabled. Xong nhaáp OK. 

Hoäp thoaïi Route Layer xuaát 
hieän, nhaáp chuoät vaøo bieåu töôïng Close ôû 
goùc phaûi phía treân hoäp thoaïi. 
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 Ñeå chöông trình töï ñoäng chaïy maïch in, nhaáp choïn Auto > Autoroute > Board. 

 
 Sau moät luùc chôø chöông trình chaïy maïch in, thoâng baùo sau xuaát hieän, nhaáp OK ñeå thaáy 
sô ñoà maïch in. 

 
 Chöông trình chaïy maïch in nhö hình sau: 

 
 Trong hình chöông trình chaïy maïch in khoâng hoaøn thaønh, coøn moät soá ñöôøng chöông trình 
chöa thieát keá maïch in ñöôïc. Tieán haønh saép xeáp laïi, tröôùc khi saép xeáp laïi, haõy gôû nhöõng ñöôøng 
maïch in ñaõ thieát keá tröôùc baèng caùch nhaáp choïn Auto > Unroute >Board. 
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 Sau khi gôû nhöõng ñöôøng maïch in cuõ, nhaáp chuoät vaøo bieåu töôïng Reconnect Mode vaø 
bieåu töôïng Component Tool treân thanh coâng cuï ñeå di chuyeån linh kieän.  

 
 Sau khi di chuyeån linh kieän xong, caùc linh kieän trong maïch ñöôïc saép xeáp nhö sau: 

 
 Haõy nhaáp choïn Auto > Autoroute > Board ñeå cho chöông trình töï ñoäng chaïy maïch in 
laïi. Sau khi chöông trình chaïy maïch in laïi, maïch in ñaõ ñöôïc thieát laäp nhö sau: 

 
 Ñeå ñaët nhaõn hieäu cho maïch in, nhaáp chuoät vaøo bieåu töôïng Text Tool treân thanh coâng cuï. 
nhaáp phaûi chuoät vaøo maïch in, moät cöûa soå xuaát hieän, nhaáp chuoät vaøo New… 

 
 Hoäp thoaïi Text Edit xuaát hieän, taïi khung Text String nhaäp teân caàn ñaët cho maïch vaøo. 
Nhaäp teân xong nhaáp OK. 
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 Con troû chuoät xuaát hieän haøng chöõ vöøa nhaäp, haõy di chuyeån con troû ñeán vò trí caàn ñaët cho 
nhaõn hieäu vaø nhaáp chuoät. 

 
 Neáu thaáy khung chöõ vôùi chieàu cao maëc ñònh khoâng töông xöùng vôùi khung maïch in neân 
tieán haønh thay ñoåi ñoä cao, khoaûng caùch giöõa caùc chöõ baèng caùch nhaáp ñuùp vaøo khung chöõ, hoäp 
thoaïi Text Edit xuaát hieän. Taïi khung Line Width nhaäp soá 30, taïi khung Text Height nhaäp soá 
150. Nhaäp xong nhaáp OK. 
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 Khi ñoù maïch in hoaøn chænh nhö sau: 

 
 Cuoái cuøng, nhaáp chuoät vaøo bieåu töôïng Save treân thanh coâng cuï ñeå giöõ laïi nhöõng gì ñaõ 
thöïc hieän. 
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